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1.0 Critical Information 

This section lists any critical issues for the current release that were known when this readme was 
published. For critical information found later, go to the Knowledge Center on the Empower website. 

http://documentation.softwareag.com/
http://techcommunity.softwareag.com/
https://empower.softwareag.com/
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2.0 Known Issues 

This section lists any issues for the current release that were known when this readme was published. 
For known issues found later, go to the Knowledge Center on the Empower website. 

▪ WED-7741 
Cloud deployment fails as Integration Cloud solutions are not available for election. 
Deploying Integration Server packages and configuration assets fail as Integration Cloud solutions 
to which the packages and assets should be deployed are not available for selection from Designer. 
This issue is caused due to some schema changes done at Integration Cloud. 
There is no workaround for this issue. 

▪ WED-7728 
Following issues exist related to the Landscape navigator, Configuration browser, and Asset Build 
Environment:  
- When using Configuration project, there is no support to deploy assets to cloud.  
Workaround: Use Deploy to Cloud option in Designer to publish assets to cloud.  
- When creating Command Central definition, the connection to Command Central server is not 
enabled when using the Installation Directory.  
Workaround: Use the Command Central URL directly. For example, https://localhost:8091/cce  
- Configuration Chooser dialog in the Cloud Publish wizard does not have a refresh option. 
Workaround: Open the Landscape Navigator, refresh the required runtime, and then open the 
Cloud Publish wizard.  
- Default Asset Build Environment definition is not created in a new Designer workspace. 
Workaround: Open the Asset Build Environment preference and create an Asset Build 
Environment definition by specifying the Software AG installation directory.  
- You should export only those configurations that are supported for Cloud deployment from the 
Landscape Navigator. However, Designer does not validate this and as all configurations can be 
exported.  
Workaround: Selects configurations that are supported.  
- Labels and Messages from Landscape Navigator and Configuration Project are not localized. 
There is no workaround to this issue. 

▪ WED-7652 
Compare and merge fails to work as expected for two flow services containing Try-Catch or Try-
Finally flow steps.  
Following issues exist when comparing and merging two flow services containing Try-Catch or 
Try-Finally flow steps:  
- Merge functionality is disabled.  
- Compare editor displays incorrect properties of flow services.  
There are no workarounds for these issues. 

▪ WED-7651 
The warning message icon is not displayed in the Layout tab for flow services containing Try-Catch 
or Try-Finally steps.  
In the Layout tab, whenever an incorrect flow step is selected or an existing step is deleted after the 

https://empower.softwareag.com/
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Try step, the icon displaying the warning message does not appear. However, it appears in the Tree 
tab.  
There is no workaround for this issue. 

▪ WED-7369 
Swagger UI hangs upon clicking the Authorize button. 
In Designer, on clicking the Authorize button and then the Close button on the Swagger UI tab of a 
REST API descriptor, the Swagger UI hangs. 
To work around this issue, close and open the Swagger UI. 

▪ WED-7127 
Issues with compare and merge functionality for Adapter elements.  
In Designer, compare and merge functionality for Adapter elements allows you to track and merge 
changes from the same server or from different servers and also from the version control history. 
However, following issues exist with this functionality for Adapter elements:  
- Sometimes, comparing two adapter services of SELECT template fails after updating the element, 
as the compare editor highlights only the empty rows and cells.  
- For Adapter update Notification elements, row indexes are improperly calculated while merging 
the "Added" table data from left to right direction.   
- In some cases merging two different Adapter Services fail with following exception:  
"Internal error. Unexpected value at 
'com.softwareag.is.ui.diffmerge.internal.UndoableMergeDiffNodeOperation#addTypedAdapter: 
363’. Expected 'com.softwareag.is.compare.structure.IComparatorElement', actual 'null'." 
There are no workarounds for these issues. 

▪ WED-6713 
In the IS Asset Compare view, you cannot merge the enabled or disabled property of a flow step or 
transformer obtained from comparing two Integration Server elements. 
There is no workaround for this issue. 

▪ WED-6227 
During refactoring, preview of the new and old value is unavailable for webMethods messaging 
trigger. 
There is no workaround for this issue. 

▪ WEL-6 
When you use Team Foundation Server (TFS) as your VCS client, TFS issues an 
IllegalArgumentException exception when sharing the local service development project. 
To work around this issue, clear the 'Connect mapped projects to TFS automatically' check box in 
Window > Preferences >Team > Team Foundation Server before sharing the local service 
development project. 
There is no workaround for this issue. 

▪ WED-7129 
Logged Fields view fails to reflect the updated signature structure. 
If you merge a service signature structure, then the Logged Fields view does not reflect the updated 
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signature structure. 
There is no workaround for this issue. 

3.0 Usage Notes 

This section provides any additional information you need to work with the current release of this 
product. 

Try it out option in Swagger UI – If GET operation has parameters that are not of type PATH, then 
before executing the operation inside the editor, change the parameter type to Query. This is because, 
the parameter defaults to FORMDATA and GET operation supports only FORMDATA. 

In Designer, on clicking the Authorize button and then the Close button on the Swagger UI tab of a 
REST API descriptor, the Swagger UI hangs. To workaround this issue, close and open the Swagger UI. 

4.0 Fixes Included in Each Release 

This section lists the latest fix level that has been included in each release for each product component. 
A release is listed in this section only if changes occurred in that release. Go to the Knowledge Center 
on the Empower website for detailed information about fixes. 

Release 10.3 

▪ ESB_10.1_Fix6 

▪ ESB_10.2_Fix2 

Release 10.2 

▪ ESB_9.6_Fix7 

▪ ESB_9.7_Fix10 

▪ ESB_9.8_Fix7 

▪ ESB_9.9_Fix8 

▪ ESB_9.10_Fix8 

▪ ESB_9.12_Fix9 

▪ ESB_10.1_Fix3 

https://empower.softwareag.com/
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Release 10.1 

▪ ESB_9.6_Fix6 

▪ ESB_9.8_Fix6 

▪ ESB_9.9_Fix7 

▪ ESB_9.10_Fix5 

▪ ESB_9.12_Fix6 

▪ ESB_10.0_Fix2 

Release 10.0 

▪ ESB_9.5_SP1_Fix9 

▪ ESB_9.7_Fix9 

▪ ESB_9.8_Fix5 

▪ ESB_9.9_Fix5 

▪ ESB_9.10_Fix3 

▪ ESB_9.12_Fix2 

Release 9.12 

▪ ESB_9.10_Fix2 

▪ ESB_9.9_Fix3 

▪ ESB_9.8_Fix4 

▪ ESB_9.7_Fix7 

▪ ESB_9.5_SP1_Fix8 

Release 9.10 

▪ ESB_9.9_Fix2 

▪ ESB_9.8_Fix2 

▪ ESB_9.7_Fix5 

▪ ESB_9.6_Fix5 
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Release 9.9 

▪ ESB_9.8_Fix1 

▪ ESB_9.7_Fix4 

▪ ESB_9.5_SP1_Fix7 

Release 9.8 

▪ ESB_8.2_SP3_Fix15 

▪ ESB_9.0_SP1_Fix9 

▪ ESB_9.5_SP1_Fix6 

▪ ESB_9.6_Fix4 

▪ ESB_9.7_Fix2 

Release 9.7 

▪ ESB_8.2_SP3_Fix14 

▪ ESB_9.0_SP1_Fix6 

▪ ESB_9.5_SP1_Fix5 

▪ ESB_9.6_Fix3 

Release 9.6 

▪ ESB_8.2_SP3_Fix12 

▪ ESB_9.0_SP1_Fix5 

▪ ESB_9.5_SP1_Fix4 
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5.0 Other Resolved Issues 

This section lists the issues that were resolved in each release but were not part of the fixes listed in the 
previous section. A release is listed in this section only if changes occurred in that release. 

Release 10.2 

▪ WED-6898 
The Designer session keeps retrying a connection if sessions are not closed explicitly by the user. 
When a user does not close the Designer sessions explicitly, Designer restores the connection to the 
Integration Server with old credentials and Integration Server raises a flowTimeoutException. 
The issue is now resolved. Designer identifies the condition when credentials are invalid and then 
stops the connection. 

▪ WED-7121 
Unable to create web service descriptor from Designer.  
Creating a Web Service Provider and Consumer descriptor in Designer fails with following error: 
'http://apache.org/xml/features/disallow-doctype-decl&#39; not recognized. 
This issue is now resolved. 

Release 10.1 

▪ WED-6957 
Execute an Adapter service with InputFieldType (in the Which tab) 'java.lang.Byte' by providing a 
value that exceeds the limit, an error message appears informing the same. Later, if you execute the 
same Adapter service by changing the InputFieldType to 'java.lang.String', the same error message 
appears preventing the service execution, even if you provide correct values. 
This issue is now fixed. 

▪ WED-6846 
In a transformer, if the output variables (Pipeline Out to Service Out or the reverse way)are 
mapped before the input variables (Pipeline In to Service In or the reverse way), the map step 
containing the transformer saves an incorrect value and hence,the flow service fails with incorrect 
results. 
This issue is now fixed. 

▪ WED-6434 
When using Designer to invoke the pub.flow:setResponseCode service, if the responseCode input 
variable value is set to 204, the Results view displays an exception. 
This issue is now fixed. 

Release 10.0 

▪ WED-6370  
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Dropping an input array variable that is part of a ForEach mapping results in an exception. 
This issue is now fixed. 

▪ WED-6311 
Changes made in Pipeline view do not reflect in the Data Mapper view immediately. 
This issue is now fixed. 

Release 9.12 

▪ WED-6034 
Designer fails to handle the URL redirections while creating Integration Server elements. 
In Designer, if the URL has redirection, creation of Integration Server elements, such as web service 
descriptors, document types, and Integration Server schema from external URL fail. 
This issue is now fixed. 

▪ WED-5592 
Tooltips remain frozen in Designer. 
In Designer, the document or flow editor tooltips remain on the screen even after closing the editor 
using the keyboard shortcut Crtl+W. 
This issue is now fixed. 

▪ WED-5820 
Designer fails to display the details of Forms tab for Custom Remedy Adapter. 
Forms tab does not display the details of Custom Remedy Adapter service such as the 'Selected 
Form' details in Designer. 
This issue is now fixed. 

▪ WED-5611 
Web service descriptor fails to generate xsd:any element and attributes when the 'Allow 
unspecified fields' property is set to true. 
The WSDL document for a web service descriptor does not include the xsd:any element and 
attributes when the web service descriptor uses a Document variable for which the 'Allow 
unspecified fields' property is set to true. This issue occurs even if the server configuration 
parameter watt.core.schema.createSchema.omitXSDAny is set to false. 
This issue is now fixed. 

▪ WED-5210 
When unresolved package issues are manually resolved in a Java service, Designer does not 
append the import details correctly to other Java services in the same folder of the package if they 
are also open in the editor. 
While editing Java services, upon doing an Organize Imports operation in a Java service, Designer 
removes necessary import details of other Java services that are in the same folder in the package if 
they are currently open in the editor. If the import details that are removed from the other services 
are manually resolved, the import details of the first service get corrupted, instead of getting 
appended to the existing import details. 
This issue is now fixed. 
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▪ WED-6204 
The field name abbreviator, as used for XmlData, truncates the field names that start or end with '#'. 
When you run a flow service, Designer fails to display the parameter names that start or end with # 
in the Results window. The Field name abbreviator, as used for XmlData, truncates the field names 
that start or end with '#'. 
 This issue is now fixed. 

Release 9.10 

▪ WED-5339  
After installing a fix or a version of Integration Server that includes PIE-30233, a pipeline link (map 
or mapping) where the destination is a Document reference variable with an unresolved document 
type reference, behaves differently at run time. 
When executing the pipeline link, at run time, Integration Server ignores the field order defined in 
the target Document reference variable which results in unpredictable field ordering in IData. 
This issue is now fixed. 
Note: Integration Server versions 9.7, 9.8, and 9.9. 

▪ WED-5692  
There is no keyboard shortcut to drop variables from the pipeline. 
This issue is now fixed. Ctrl+Shift+O is the new keyboard shortcut to drop variables from the 
pipeline. 

▪ WED-5584  
While searching for Integration Server elements in all packages, Designer does not work as 
expected when installed with a non-English language pack.  
If you select All Packages option while searching for an Integration Server element in Designer 
(Search -> Integration Server), Designer searches for the element in all the packages before 
displaying the results. However, if Designer is installed with a language pack other than English, 
Designer does not search for the element in all packages. As a result, no results are displayed. 
This issue is now fixed. 

▪ WED-5397 
Performance of Designer slows down when saving a flow service with a large number of service 
references. While saving a flow service, Designer checks whether the services referenced in the flow 
service exists. As a  result, if there are a large number of service references in the flow service, the 
performance of Designer slows down. 
This issue is now fixed. A new flow service editor preference is introduced.  In the Flow Service 
Editor preferences page, if you do not want Designer to validate the referenced services while 
saving a flow service, clear the Validate service references while saving check box. Clearing this 
preference improves the performance of Designer while saving a flow service. By default, this check 
box is not selected. Select the Validate service references while saving check box if you want 
Designer to validate the referenced services while saving a flow service. 

▪ WED-5210 
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When user selects Organize Imports to fix a JAVA service, it fixes the import statements of that 
service but the import statements in other JAVA services fails in the same folder. 
This issue is now fixed. 

▪ WED-5464 
If Centrasite is selected as the source of the WSDL or XML schema definition, Designer does not 
display the child organizations when creating a web service descriptor or an IS document type.  
When creating a consumer or WSDL first provider web service descriptor from a service asset in 
CentraSite or an IS document type from an XML Schema definition in CentraSite, Designer does not 
display the assets that belong to the child organizations.  
This issue is now fixed. Now, if Centrasite is selected as the source of the WSDL or XML schema 
definition when creating a web service descriptor or an IS document type, Designer lists the child 
organizations  

▪ WED-5465 
If you set the Pre-8.2 compatibility mode property to true for a web service descriptor using 
Designer, StackOverflowException occurs.  
If the web service descriptor contains a recursive document type reference, using Designer to set 
the Pre-8.2 compatibility mode property to true results in a StackOverflowException. 
This issue is now fixed. 

6.0 Documentation Changes 

This section describes significant changes to the documentation, such as the addition, relocation, or 
removal of product guides, online help, chapters, or other major content. A release is listed in this 
section only if changes occurred in that release. 

Release 10.3 

▪ Service Development Help contains a new chapter, ”Deploying to Cloud”, which explains how to 
deploy Integration Server packages and configuration assets (Integration Server and Universal 
Messaging configurations) to Integration Cloud using Designer.  

▪ Service Development Help contains a new chapter, Command Central Preferences, which explains 
how to customize Landscape navigator view, monitoring, and project settings for Command 
Central runtime components using Designer. 

▪ Service Development Help contains a new chapter, Integration Cloud Preferences, which describes 
the settings required for configuring an Integration Cloud connection. 

▪ Service Development Help contains a new chapter, “Working with Recipes”, which explains how to 
install or download and use recipes as a package using Designer. 
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Release 10.2 

▪ Service Development Help contains a new chapter, “Publishing and Retracting Metadata for IS and 
TN Assets,” which explains how to publish and retract metadata for Integration Server (IS) assets, 
and Trading networks (TN) document types to and from the CentraSite shared registry. 

▪ The Developing Microservices with webMethods Microservices Container guide has been renamed 
Developing Microservices with webMethods Microservices Runtime to reflect the product name change 
from webMethods Microservices Container to webMethods Microservices Runtime.  

▪ Service Development Help contains a new chapter, “Working with WebSocket Endpoints”, which 
explains what a WebSocket endpoint is and how to create a WebSocket client endpoint and 
WebSocket Server endpoint. 

Release 10.0 

▪ Service Development Help contains a new topic, Building Map Services, which explains what is a 
map service and how to create a map service. 

Release 9.9 

▪ Service Development Help contains a new topic, Working with XML Document Types, which 
explains what XML document types are and how to create XML document types. 

▪ Service Development Help contains a new topic, Comparing Integration Server Packages and 
Elements, which tells you how you can compare packages and elements in Integration Server using 
the compare tool. 

▪ Service Development Help contains the Managing Cloud Connector Services topic, which was 
earlier available only in the documentation specific to your CloudStreams provider (for example, 
webMethods CloudStreams Provider for Salesforce.com Installation and User's Guide). 

Release 9.8 

▪ Service Development Help contains a new topic, Working with OData Services, which provides 
information about how to create and edit OData services. 
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7.0 Terminology Changes 

A release is listed in this section only if changes occurred in that release. 

Release 10.3 

Old Term New Term 

Named object Durable subscription or durable. 

As of Universal Messaging version 10.2, the term 
named object has been replaced with durable 
subscription or its abbreviated form durable. 

A serial webMethods messaging trigger 
corresponds to a serial durable subscription (or the 
abbreviated serial durable) on Universal 
Messaging. A concurrent webMethods messaging 
trigger corresponds to a shared durable 
subscription (or the abbreviated shared durable) on 
Universal Messaging.  

Release 10.2 

Old Term New Term 

webMethods Microservices Container webMethods Microservices Runtime 

8.0 Added, Removed, Deprecated, or Changed Items 

This section lists functionality, controls, portlets, properties, or other items that have been added, 
removed, deprecated, or changed. A release is listed in this section only if changes occurred in that 
release. 

Release 10.3 

Added Item Description 

EXIT step Exit from property value $iteration The Exit from property now includes $iteration as 
a possible value to specify exiting from an iteration 
of the nearest ancestor LOOP or REPEAT flow 
step. 
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Added Item Description 

Enhancements to REST V2 resources for JSON 
API support 

- Designer provides following options for JSON 
API support in the rest resource creation wizard: 
“Empty Rest resource and Document type based 
REST resource” while creating a rest resource.  

- Designer provides an additional tab called 
"Attribute configuration" for adding attributes to 
the REST V2 resource.  

- New property “Generate JSON API URLs” is 
added to the property view of a REST V2 resource. 

Integration Cloud preference Integration Cloud preference page enables 
Designer to connect to Integration Cloud (Window 
> Preference > Software AG > Integration Cloud). 

Support for Recipes in Integration Server / 
Designer 

A new view called ‘Recipes’ is added under 
Window > Show View > Other… for viewing, 
searching, installing, and downloading the Recipes 
in Designer. 

Designer UI support for Try-catch block for flow 
services 

- Designer now provides the following new flow 
steps for in the palette view and context menu: 
TRY-CATCH, TRY-FINALLY, CATCH, and 
FINALLY.  

- Designer provides a new context menu option 
called “Transform to > Try Catch Step / Try Finally 
Step” for SEQUENCE flow step.  

- Designer displays a warning icon along with the 
message upon mouse hover in the flow editor 
when user uses an invalid TRY-CATCH or TRY-
FINNALY combination. 

Deployment to Integration Cloud Using Designer you can now seamlessly deploy 
your on-premise Integration Server packages and 
configuration assets to solutions present on 
Integration Cloud. 
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Changed Item Description 

EXIT step Exit from property The default value of the Exit from property is now 
$parent which indicates the flow will exit from the 
parent flow step, regardless of the type of step. 
Previously, the default value was <blank> which 
equated to nearest ancestor LOOP or REPEAT flow 
step. 

Serial webMethods messaging triggers that 
receive documents from Universal Messaging 
now process documents from a publisher in 
publication order in a load-balanced fashion.  

Previously, a webMethods messaging trigger with 
serial processing corresponded to a priority named 
object on a channel on Universal Messaging server. 
Now, a serial webMethods messaging trigger 
corresponds to a serial durable subscription 
(named objects in Universal Messaging are now 
called durable subscriptions). This provides 
processing in publishing order for a serial trigger 
in a cluster or a non-clustered group of Integration 
Server. Over time, it allows for the Integration 
Server in a cluster or non-clustered group to 
process messages in a load balanced fashion.  

Release 10.2 

Added Item Description 

WebSocket Endpoints You can configure WebSocket endpoint that act as a 
server or client type. Implementation of WebSocket 
endpoints and its accompanying services enable you 
to develop and deploy applications that 
communicate with clients. 

Circuit Breaker You can configure a circuit breaker feature for a 
service that resides in a webMethods Microservices 
Runtime.  To configure a circuit breaker with a 
service running on Integration Server, your 
Integration Server must have additional licensing. 

Sync to DES property for IS document types Indicates whether Integration Server automatically 
synchronizes this document type with a 
corresponding Digital Event Services event type 
definition in the Digital Event Services repository 
upon save. Set this property to true if the 
document type is used to define the structure and 
content for the value of an “any” field in a 
document that is published to Digital Event 
Services. 
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Enhancements to REST API descriptor - Designer provides a Swagger UI view that 
surfaces the open source Swagger UI and Try it out 
option developed for Swagger. 
- Swagger Syntax Coloring preference page is now 
available to set the font color and styles of tokens 
in a Swagger document. 
- Run option in the REST API descriptor editor 
enables execution of selected REST operations 
available in REST API descriptor. 

Enhanced support for REST V2 resources New properties are added to the property view of 
a REST V2 resource. 

 

Removed Item Replacement, if any 

Creating an IS document type from a file in 
webMethods Content Service Platform 

None. The webMethods Content Service Platform 
is no longer available.  

Release 10.1 

Added Item Description 

Support for REST V2 resources REST V2 resources provide a flexible way of 
defining resources for REST requests. In the Service 
Development perspective, a developer can define a 
REST V2 resource with operations that include the 
following: 

• The format of the URL that REST clients 
must follow when sending requests to Integration 
Server acting as the REST server. 

• The HTTP methods supported by the 
resource operation. 

• The flow service associated with a resource 
operation. 

Support for REST API descriptors for REST V2 
resources 

In addition to creating REST API descriptors from 
resources that use the rest directive, the Service 
Development perspective now provides the ability 
to create REST API descriptors from REST V2 
resources. 
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Added Item Description 

Support for REST API Descriptor from Swagger 
Document 

The Service Development perspective now 
provides the ability to create REST API descriptors 
from external Swagger documents accessible 
through a URL, a REST resource on API Portal, or a 
REST resource residing in CentraSite. 

Microservices Container running in a Docker 
container as local service development server. 

Designer provides support for the local service 
development feature to use a Microservices 
Container running in a Docker container as the 
local development server.  

 

Removed Item Replacement, if any 

REST Resource Configuration The REST Resource Configuration page of the 
Properties dialog box for a selected service option 
has been removed. 
An alternate option is provided through the 
creation of new REST V2 assets. 

Release 10.0 

Added Item Description 

Case sensitive check box  The Case sensitive check box in the Integration 
Server Search tab of the Search menu allows you to 
perform a case-sensitive search for the names of 
Integration Server elements. 

Exact match check box The Exact match check box in the Integration 
Server Search tab of the Search menu allows you to 
search for an Integration Server element with a 
name that exactly matches the specified search 
string. 

Map service Designer allows you to create map services that 
can be reused in different flow services. A map 
service can be used to map document types of 
different formats. 

PATCH check box The PATCH check box in the New REST Resource 
configuration wizard of the Service Development 
perspective allows you to specify PATCH as a 
supported method for creating a REST resource. 
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Added Item Description 

REST Resource Configuration The REST Resource Configuration page of the 
Properties dialog box for a selected service 
provides you with options to configure, edit, and 
delete REST resources for the particular service. 

Convert to Local Service Development Project Using the Convert to Local Service Development 
Project option in the context menu allows you to 
convert a non-Local Service Development package 
to a Local Service Development package by adding 
the VCS and Java project nature to packages that 
contain the Java and C/C++ services. 

ForEach debugging Designer now allows you to debug a ForEach 
mapping. 

Allowed HTTP Methods property The Allowed HTTP Methods property for a service 
enables you to select the HTTP methods that you 
can configure for the particular service. The 
supported methods are GET, HEAD, PUT, POST, 
PATCH, DELETE, and OPTIONS. 

 

Removed Item Replacement, if any 

Add VCS project Nature Convert to Local Service Development Project in 
the context menu allows you to add the VCS and 
Java nature to packages while you are working 
with local service development. 

 

Changed Item Description 

Port alias property For a binder in a provider web service descriptor, 
you can now set the Port alias property to the 
default provider endpoint alias when the binder 
uses the HTTP or HTTPS protocol.  

Release 9.12 

Added Item Description 

Comparing and merging JMS triggers, adapter 
services, and adapter connections 

JMS triggers, adapter services, and adapter 
connections can now be visually compared and 
differences between versions can be merged. 
Previously, merging was available only for flow 
services and IS document types. 
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Added Item Description 

Debug to Here Debug to Here option in the context menu allows 
you to debug a flow service up to the specified 
flow step. 

Data Mapper Data Mapper view in Designer allows you to 
execute, modify, and test a MAP step without 
saving the flow service. 

ForEach mapping Designer provides ForEach mapping approach in 
the pipeline view of a MAP step to simplify array 
mapping and array data processing. 

Move project to Integration Server package as 
linked resource 

Move project to Integration Server package as 
linked resource option in the Local Service 
Development Preferences, allows you to set any 
repository on your workspace as the local 
repository directory and a linked directory is 
created under the Integration 
Server_directory\instances\default\packages 
directory. 

Digital Event Services (DES) From Designer, a user can integrate with Digital 
Event Services using the existing webMethods 
Messaging infrastructure. Also, Annotations 
property is now available for publishable 
document types that use the 
IS_DES_CONNECTION messaging connection 
alias. 

Search and Refactor Search functionality now provides the ability to 
search for a particular variable and identify all 
references to that variable in other assets, such as 
flow services, document types, specifications, and 
triggers. 
The Refactor option in the context menu allows 
you to refactor the input/output variables of 
various Integration Server assets (for example, flow 
services, Java services, specifications, documents 
type). 

API Portal The API Portal metadata repository type in the 
Asset publish wizard helps a user to configure 
connections to API Portal and publish REST API 
descriptors. 
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Changed Item Description 

Processing mode property default The default processing mode for JMS triggers and 
webMethods messaging trigger is now changed 
from Serial to Concurrent. 
The value for ‘Max execution threads’ is changed 
from 10 to 1. 

Encoding type property default The default encoding type for publishable 
document type associated with a Universal 
Messaging connection alias is now Protocol 
buffers. Previously, the default encoding type was 
IData. 

Release 9.10 

Added Item Description 

REST API Descriptor A descriptor for a group of REST services on 
Integration Server. 

Merging Integration Server Elements Merge capability allows you to merge the 
differences between two elements on the same 
server or on different servers. Merging is available 
for flow services and Integration Server document 
types. 

LCVI: Integration Server instance need not be 
named ‘default’ to use as LCVI. 

Multiple Integration Server local instances can now 
be made as Local Version Control Integration 
Server (LCVI). 

Validate service references while saving  
preference 

Flow service editor preference for validating all of 
the referenced services in the flow service upon 
saving the service. 

Rest API Descriptor Preference Preference for specifying MIME type available for 
use with REST API descriptors. 

OData service creation from external sources OData service can now be created using an external 
source type. 

Changed Item Description 

REST Resource folder icon A folder that contains services that function as a 
REST resource now has a unique icon to 
differentiate it from a folder that does not contain 
any services or elements used as a REST resource. 
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Release 9.9 

Added Item Description 

XML document type An XML document type corresponds to a global 
element declaration, global attribute declaration, or 
global complex type definition in an XML schema 
definition. 

Deprecated Item Replacement, if any 

WmVCS and VCS Integration feature Use the local service development feature (Local 
Version Control Integration) to check package 
elements and their supporting files into and out of 
a version control system (VCS) directly from 
Designer. 

Changed Item Description 

Serial webMethods messaging triggers that 
receive documents from Universal Messaging 
now process documents from a publisher 
publication order.  

Previously, a webMethods messaging trigger with 
serial processing corresponded to a shared named 
object on a channel on Universal Messaging server. 
Now, a serial webMethods messaging trigger 
corresponds to a priority named object. This 
provides processing in publishing order for a serial 
trigger in a cluster or a non-clustered group of 
Integration Server 

Release 9.8 

Added Item Description 

OData service wizard and editor New wizard and editor to create, view, and edit 
OData services.  

Support for VCS operations from the Package 
Navigator view 

VCS operations can now be performed on elements 
from Package Navigator view for Local 
Development. 

Changed Item Description 

Default value of the Hide generated flow services 
preference. 

The Hide generated flow services check box in the 
In the Preferences dialog box under Software AG > 
Service Development > Package Navigator is now 
cleared by default.  

9.0 Copyright Information 

Copyright © 2018 Software AG, Darmstadt, Germany and/or Software AG USA Inc., Reston, VA, USA, 
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and/or its subsidiaries and/or its affiliates and/or their licensors. 

The name Software AG and all Software AG product names are either trademarks or registered 
trademarks of Software AG and/or Software AG USA Inc. and/or its subsidiaries and/or its affiliates 
and/or their licensors. Other company and product names mentioned herein may be trademarks of 
their respective owners. 

Detailed information on trademarks and patents owned by Software AG and/or its subsidiaries is 
located at http://softwareag.com/licenses.  

This software may include portions of third-party products. For third-party copyright notices, license 
terms, additional rights or restrictions, please refer to "License Texts, Copyright Notices and 
Disclaimers of Third Party Products". For certain specific third-party license restrictions, please refer to 
section E of the Legal Notices available under "License Terms and Conditions for Use of Software AG 
Products / Copyright and Trademark Notices of Software AG Products". These documents are part of 
the product documentation, located at http://softwareag.com/licenses and/or in the root installation 
directory of the licensed product(s). 

10.0 Support 

Visit the Empower website to learn about support policies and critical alerts, read technical articles and 
papers, download products and fixes, submit feature/enhancement requests, and more. 

Visit the TECHcommunity website to access additional articles, demos, and tutorials, technical 
information, samples, useful resources, online discussion forums, and more. 

SD-RM-103-20181015 

http://softwareag.com/licenses
http://softwareag.com/licenses
https://empower.softwareag.com/
http://techcommunity.softwareag.com/
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